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Abstract 
 
How many Different Ways? 
Instructions: Using the grid below, go from Point A to Point B without backtracking. 
Recognize that you will likely choose a different path than your neighbor. Try to figure out just 
how many ways a person can connect the dots. There try to figure out how many ways there 
are of figuring out how many ways there are. 
 
Helpful Tools: An open and flexible mind 
 
Objectives: Introduce the problem solving, critical thinking, patient, and creative skills 
necessary for computer learning 
 

A   •    •    •    •    •    •    •    •    •    • 
•    •    •    •    •    •    •    •    •    •    • 
•    •    •    •    •    •    •    •    •    •    • 

 •    •    •    •    •    •    •    •    •    •    B 

 
 
 
 

Essential Vocabulary 

 
Computer 
What is a computer? A computer is an electronic device that is used to receive, store, process, 
and retrieve information through mathematical, logical, and graphical functions. Computers are 
useful for their ability to work relatively quickly and accurately with high amounts of data. The 
main elements of a computer’s hardware are the Central Processing Unit (CPU), the computer 
memory. The CPU is connected to input devices to receive data from the user (i.e. the mouse, 
keyboard, and microphone) and output devices to return information to the user (i.e. the 
monitor, printer, and speakers).  
 
Hardware 
The hardware of the computer is the tangible and physical parts of the computer, including the 
monitor, mouse, keyboard, memory cards and chips, etc.  
 
Software 
The software of the computer is the non-tangible sets of instructions programmed into and 
read by the computer, including programs and applications.  
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Program 
The user typically interacts with the computer through a series of programs. A program is a set 
of instructions given to the computer for a specific task. Examples of programs include 
Microsoft Office Word, Microsoft Office Excel, Paint, etc.  
 
Start Menu 
Found on the bottom left corner of the screen, this is the button through which all programs 
can be accessed. 
 
Desktop 
The first screen that appears when you log on. There are typically a number of icons and/or 
folders and documents found in front of some sort of image or screen saver. As you open 
programs, they open in front of this desktop.  
 
Microsoft Office Word 
Word is a word processing program. Its primary function is to allow users to compose 
documents. Through Word documents can be typed, saved, and printed.  
 
 
Microsoft Office Excel 
Excel is a spreadsheet program. Its primary function is to assist in the compilation and 
presentation of numerical information. It can be used to calculate, graph, create tables and 
charts, and arrange and analyze data. 
 

Using the Mouse 

 The Cursor: the arrow, blinking line, or other little icon that indicates where on the 
screen the user is working 

 To Click: press with your first finger on the left side of the mouse and quickly release 
- To select an icon 

 To Double-click: click twice (on the left side of the mouse) in quick succession 
- To select a file, program or function 

 To Right-click: 
- To open a menu particular to the current action or program 

 To Highlight (or Select): click on either side of a portion of text, hold down the left 
button of the mouse, and drag to cover the text.  
- To select text or other material for editing/manipulation 

 

Using the Keyboard:  

 Capital letter (just one or a few): Hold down the Shift key and press the letter(s) at the 
same time) 

 Capital letters (a series of): Caps Lock 
 Indent or move to next cell: Tab 

 Navigate on the screen without having to the use the mouse: the arrow keys found in 
the bottom right area 

 Paragraph/line/cell below: Enter (or Return) 
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 Punctuation or other figures found on the top of the keys: Press Shift and then press the 
desired key 

 Rub something behind (to the left of) the cursor: Backspace 

 Rub something in front of (to the right of) the cursor: Delete 
 Select All (an alternative to the Highlighting described in the above mouse section: 

While holding down Ctrl, press ‘A’.  
 Space between words: press the space bar in the bottom center of the keyboard 

 

Using Programs 

 The Window: the portion of the screen containing an open program 

 To open: double-click on the icon OR right click and select ‘Open’ 
 To close: click on the X at the top right of the window 

 To maximize (change the size of the window on the screen): click the box found just to 
the left of the closing X 

 To minimize (put out of sight temporarily): click the underscore found two to the left of 
the closing X 

 
 

Microsoft Office Word 
 
To open (starting from the desktop): Start  All Programs  Microsoft Office  Microsoft 
Office Word 
 

Tutorial 1: Exploration 

All Microsoft Programs have a similarly arranged toolbar at the top of their windows. In 
Word, you will see the toolbar includes the Home, Insert, Design, Page Layout, and References 
tabs. To give you a basic idea of the scope of the program, some of the possibilities within each 
of these tabs are listed below. However, to best learn the workings of the program, it is best if 
you explore each of the tabs on your own to discover how the different tools work. 
 
Tip: Pressing the F1 key will connect you with Word Help, where you will likely be able to 
find the answer to most any question about using Word. 
 

● If you hover your mouse over an icon, often it will give you a description of its function. ● 
 
Remember: If you want to somehow edit a text using a tool on the Home tab or another part of 
the tool bar, you must first select the text by highlighting it (Ctrl + A OR click, hold, and 
drag). Otherwise, even if you click on a tool in the toolbar, the program will not know where 
you want to apply this tool and thus will do nothing.  
 

Home Tab: underline, italicize, bold, change the font, permanently highlight, alphabetize, 
1. make 2. numbered 3. lists, text alignment, etc. 
 
Insert Tab: insert tables, charts, pictures, clip art, shapes, page numbers, etc. 
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Design Tab: choose themes and borders for your entire document. 
 
Page Layout: determine margin sizes, indentation, spacing, page orientation, columns. 
 
References: include table of contents, citations, endnotes for long/formal documents. 
 
There are many other functions within these tabs as well as other tabs. Try to click on as many 
things as you will remember in one sitting to see what they do. When you come back to the 
computer next time, see what you remember from last time and then click around to explore 
more things.  
 
 

Tutorial 2: File Maintenance 

Instructions:  
1. Open Microsoft Word: 
Click Start ( All Programs  Microsoft Office)  Microsoft Office Word 
2. Type your name. 
3. Save and name your document: 
Click the Office button (color, round, top left of screen)  Click Save As  Type a name for 

your file in the ‘File Name:’ box or use the one that is already there  Click Save 
4. Type your age and your school name. 
5. Resave your document: 
Click on the save button (just to the right of the office button)  
6. Close your document: 
 Click on the X at the top right of the screen 
7. Reopen Microsoft Word (See step 1) 
8. Open the document you just created: 
Click on the Office button  Open  Find your document and click on it 
9. Type in your document to add your friends’ names. 
10.  Once you’re finished, resave and close. 
 
 

Tutorial 3: Creating Folders 

Instructions: Start  My Documents  All Classes (double click)  Choose your class 

(double click)  Click File  Go down to New  Click Folder  Type your full name in the 

text box next to the ‘New Folder’ which has just been created  Press Enter  Your new file 
to store your personal documents and materials has been created. Now to see how you can use 
it: 

1. Open a new document in Microsoft Office Word 
2. Save this document in your new personal folder: 

Office Button  Save As  Click the right arrow at the right end of the ‘Save In:’ bar 
and select the ‘All Classes’ folder (scroll down if necessary)  continue navigating 

through the folders until you reach yours and click on it  type a name for your 
document in the ‘File Name:’ bar  Click Save. 

You have now created and saved a document in your personal folder. This is helpful because 
now you know exactly where your document is. You can access your document in different 
ways:  
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 Through Word: Click the Office Button  Open  and then navigate through the files  

 Through the Start menu: Click Start  My Documents  Desktop  All Classes  
choose your class  choose yourself  click on the document  

 Through the icon on the desktop: clicking on the ‘All Classes’ folder (which has been 
saved to the desktop)  navigate through the folders to find your document 

You can store many documents in your folder. Use computer folders as you would use paper 
folders – to keep your materials organized and able to be easily found. Once you are inside of a 
folder, you can create new folders as needed by clicking File (on the top bar)  New (drop 

down menu)  Folder. 
 
 

Tutorial 4: Keyboard Shortcuts 

Instructions: Open Microsoft Office Word and then disconnect your mouse (follow the cord of 
the mouse to the back of the CPU and unplug it). Now using your keyboard, retype the text 
found below. Make sure you pay careful attention to what you are typing and follow the 
instructions as you go.  
 
Helpful tools: 
General: 
Word Help: F1 
Office Button: Alt + F 
Right Click (for Shortcut Menu): Shift + 
F10 
Undo: Ctrl + Z 
Redo: Ctrl + Y 
 
Documents/Windows: 
Save: Ctrl + S 
Print: Ctrl + P 
New Document: Ctrl + N 
Close Active Window: Ctrl + W 

 
Text: 
Select All: Ctrl + A 
Select One: Ctrl + Shift + Arrow keys 
Copy: Ctrl + C 
Cut: Ctrl + X 
Paste: Ctrl + V 
 
Font: 
Bold: Ctrl + B 
Italicize: Ctrl + I 
Underline: Ctrl + U 

 
 
 

I am a student learning computers. Today my mouse is gone and I must only use the 

keyboard. First I would like for the next sentence to be bold. Once I finish typing this sentence I 

will hold down Control and Shift and then press the left arrow key until the whole sentence is 

selected, then I will let go of Shift, continue holding down Ctrl, and press B to bold.  

 

Second I would like to see what it looks like when this whole paragraph is underlined. So I 

will select this entire paragraph as I did in the above paragraph (Ctrl + Shift + ). Then I 

underline with Ctrl + U. Now I press Ctrl + U again to stop underlining.  
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Third, I want to italicize the next sentence, so right after this full stop I will press Ctrl + I 

and then start typing. Today is going to be a great day. I pressed Ctrl + I after I finished typing 

that last sentence, so that only that sentence would be italicized. 

 

Now I will plug in my mouse to one of the USB ports in the back of the CPU. Because I am 

learning computers, I have many questions. Because I am a very smart student, I know how to 

find answers to these questions on my own. I can do this by pressing F1, which is the keyboard 

shortcut for Word Help. Because I am an inquisitive student, I will now continue typing on my 

own and try the different Keyboard Shortcuts listed above, or maybe I will peruse the even 

longer list found in Word Help.  

 
 
 
 

Microsoft Office Excel 
 
To open (starting from the desktop): Start  All Programs  Microsoft Office  Microsoft 
Office Excel 
 
Tutorial 1: Open the Program and explore. 
The toolbar in Excel is similarly arranged to the toolbar in Word. Remember that if you hover 
over an icon on the tool bar it will often give you a description of the icon’s function or purpose.  
 
Home Tab:  font styles, text alignment within cells, numbering formats (decimal places, 
percentages, etc.), cell coloring, inserting rows and columns, summation, sorting and ordering 
 
Insert: Tables, Charts, Graphs, Filters, etc. 
 
Page Layout: Margins, Scaling to Fit (for printing), Headings 
 
Formulas: concerns the many different ways the data you entered can be calculated and 
analyzed.  
 

Overview: An excel document is called a workbook. When you open a new Excel 
workbook (analogous to opening a new Word document), it automatically contains three 
worksheets which you can access, add, and delete at the bottom of the screen). The worksheets 
contain rows (labeled by number) and columns (labeled by letter). Each cell has a cell address 
containing its row number and column letter, i.e. B6. A series of consecutive cell addresses can 
be denoted with a colon, i.e. B6:B22 refers to the cells in Column B from Row 6 to Row 22. Cell 
addresses are used in formulas so that data can be changed and the desired formulation still 
acquired.  

The active cell is the cell currently being worked in. The Formula Bar is the long bar 
just below the tool bar that shows the contents of the current cell. You can either type in the 
Formula Bar or directly in the cell. The Name Box (below the toolbar, to the left of the 
Formula Bar) is used to access and name cell addresses and sets of data.  
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 To use a formula, select the cell where you would like the formula result to be displayed. 
Then type the equals sign ‘=’ and then your formula using the cell addresses of the data you 
want to work with. You can either write your own formulas or choose any of the formulas 
found in under the formula tab. If you click on the fx just to the left of the formula bar, the 
Insert Function dialogue box will appear. You can then search for functions and be prompted 
with which information to fill in for the formula arguments. The format of some of these 
formulas takes some time to get used to, so take your time to explore the different possibilities. 
With time and dedication your skills will develop powerfully. Remember F1 is usually available 
for Excel Help as well.  
  

Tutorial 5: Creating a Mark List: 

Below is an example of one useful application of Excel Spreadsheets. It contains descriptions of 
the selection tools, Summation function, Average function, Rank function, and printing tips. 
While these tools are explained here in the context of the Mark List, they are some of the most 
frequently used tools and can be easily applied in many other contexts.  
 

1. Open a New Workbook. 
2. At the bottom of the workbook add the appropriate number of sheets to accommodate 

all class levels 
3. On the first worksheet, click on the View tab  Workbook Views section  click Page 

Layout  on the actual page ‘Click to add header’  Type the name of the first sheet 
(“Class 1 CAT 5 Term II 2015”) 

4. Click out of the header. 
5. On the View Tab click back to the Normal workbook view.  
6. Beginning in Row 1 Column A and moving across to the right, type the following 

column headings in columns A through P: Pupils, Position, Gram, Comp, Reading, 
ENG%, Lug, Insha, Kusoma, KIS%, Math, SST, CRE, SCI, Total. (or accommodate 
accordingly for upper primary)  

7. Beginning in Row 2 and working down Column A, type the names of the students in the 
class. In the cell after the last student type Total Points, then below that Mean Score, 
and finally Subject Merit. 

8. Select all of Column A, go to the Cells section of the Home Tab, select Format, and 
from the drop down menu choose AutoFit Column Width.  

9. In the first row of the ENG% column (should be cell F2) type the formula 
“=C2+D2+E2”. For an upper primary sheet type “=(C2+D2)/90*100”. 

10. Once the formula is in place in the first row, you can transfer this formula to all the 
rows below by selecting the little black box at the bottom right corner of the cell in 
which you have just entered the formula. Once your cursor is a thin black cross, click 
and drag down the column. (Do not use the thick white cross – that is for selecting 
information, not transferring relative formulas). When you drag down the column, the 
formula will remain the same but the row addresses will be updated accordingly. 
Similarly, when you transfer a formula across a row, the column addresses are updated 
accordingly.  

11. Enter similar formulas in the first row of the Kiswahili and SST/CRE percentage 
columns, using the appropriate cell addresses in the summation formula arguments. 
Transfer the formula down the column. 
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12. In the ‘Total’ column write a formula which adds the contents of the cells from each of 
the subject percentage columns (i.e. for an upper primary sheet the formula should look 
like: “=E2+H2+I2+L2+M2”).  

13. In the position first row of the position column type “=Rank(N2, N$2:N$20)”. Then 
transfer this formula down the position column. (The 20 here represents a class size of 
19…adjust accordingly for your own class. The second argument in this formula is the 
range within which the first cell address is to be ranked. The dollar signs before the 2 in 
the 20 are necessary so that the 2 and 20 do not change as the formula is dragged down 
the column. Using these dollar signs signifies absolute (unchanging) rather than relative 
(changing) reference.  

14. In the first column of the ‘Total Points’ row (the Grammar column) enter the formula 
“=SUM(C2:C20)”. Then drag this formula across the Total Points row.  

15. In the Mean Score row, enter the formula “=AVERAGE(C2:C20)” and then drag this 
one across the row.  

16. For the Subject Merit formula, you will need to make a named lists consisting of the 5 
Mean Score subject percentages. To do this, hold down the Control key (CTRL on the 
bottom left of the keyboard) while you click each of the 5 mean score percentages. Once 
you have clicked each of them and let go of the Control, all five should be selected. Then 
go to the Name Box and title this list “PercentagesClass7” (or some other name you 
prefer).  

17. Then in the Subject Merit row under the first subject percentage column, enter the 
formula “=RANK(H26, PercentagesClass7)”. Enter this formula with the appropriate 
first argument in the other subject percentage columns of the Subject Merit Row. You 
do not want this formula in all of the columns of the Subject Merit though so do not just 
drag. 

18. Proceed to fill in all known, uncalculated data. Since you have already entered the 
necessary formulas, you should see the percentages, sums, averages, and ranking 
appearing automatically as you enter data.  

19. Using the thick white cross, click and drag to select all the rows containing student 
names and scores. Then on the Home Tab, in the Editing section of the far right, select 
Sort & Filter  then Custom Sort from the drop down menu. Sort by Totals. Sort On 
Values. Order Largest to Smallest. Click OK. Your sheet should then be arranged by 
highest ranking students.  

20. For the other classes worksheets, you can copy and paste the format you have 
established for the first class by selecting all with Ctrl + A, then copy with Ctrl + C, 
then click on cell A1 of the next work sheet and press Ctrl + V to paste. Update the 
number of rows, columns, and necessary formulas accordingly. Rows, columns and 
sheets can be inserted and deleted under the Home tab, in the Cells section.  
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Assignments, Projects, and Testing 
 

Below are ideas for assignments that can be given to students to work on at their own 
pace. They can also be presented in a contest style for class work or given as an assignment for 
a formal exam once the students have had the opportunity to practice on their own.  

The tasks are intentionally open-ended so that students have ample room for creativity. 
Encourage attention to detail and exploration of all available tools in the tool bar. The 
scope/length of each project is easily modifiable for different age groups.  Ideally each task 
should take 1 to 4 hour long class periods. Remember, tutorials on how to perform many 
functions in Microsoft Programs can be found by pressing the F1 key, and brief descriptions of 
icons can be found by hovering over the icon with your cursor.  
 
Task 1: Write a short biography. 
Helpful Tools: alphabetic keys 
Objective: Keyboard familiarity  
 
Task 2: Write a Letter to a friend. 
Helpful Tools: Enter, Tab 
Objective: Typing and Formatting 
 
Task 3: List and Order your favorite things. 

Helpful Tools: Home Tab  Paragraph Section  Numbering and Bulleting Tools 
Objective: Home tab editing tools 
 
Task 4: Copy a story book page.  
Helpful Tools: alphabetic keys 
Objective: Typing practice 
Note: **This assignment can be repeated during many different class period for excellent 
practice typing. As students gain familiarity with the keyboard, being to encourage proper 
typing form (The first finger of your right hand should be on the J, the first finger of your left 
hand on the F, and your other fingers resting on the home row keys to either side of the J and 
F. Your fingers only press those keys within reach.)** 
 
Task 5: Write your own decorative story. 
Helpful Tools: Insert Tab  Text  Word Art 
Objectives: Typing, formatting, and creativity 
 
Task 6: Write a longer autobiography. 
Helpful Tools: keyboard 
Objectives: Formal typing and formatting 
 
Task 7: Make an announcement poster. 
Helpful Tools: Insert Tab  Illustrations; Home Tab  Font; Design Tab  Borders 
Objectives: Formatting, Editing tools, Design, creativity 
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Task 8: Outline a Proposal. 
Helpful Tools: References Tab  Table of Contents; Insert Tab  Header & Footer section  
Page Number 
Objectives: Formal document writing 
Note: The components of a proposal should generally include the following:  
Introduction, Vision, Mission, Description of the Problem, Beneficiaries of the Project/Target, 
Project Location, Period/Duration, Goal of the Program/Project, Project Implementation 
Strategies/Approaches, Project Implementation Strategies/Activities, Monitoring and 
Evaluation (Budget Estimates, Reports, Scope of Work), Terms of References, Works Cited 
 
Task 9: Make your own mark list 
Helpful Tools: Summation, Average, Rank functions in Excel 
Objective: Learn some of the tools available in Excel 
 
Task 10: Make a budget or supply list: 
Helpful Tools: Summation function in Excel 
Objective: to compile monetary information in an organized fashion 
 
Task 11: Rabbit/Agribusiness List 
Helpful Tools: Excel Ranking and Summation 
Objective: to determine how best to organize agribusiness information 
 
Task 12: Paint Competition 
Using the Paint program, assign students to compose an image of a house, market place, 
animal, etc and hold an election for the best drawn piece of art. 
Objective: Creativity, using the mouse effectively, exploring tools available in Paint 
 
 
 

 
Congratulations, you have now become more literate in Microsoft Office Word and Microsoft 
Office Excel. Continue to explore the many more tools available in each of these and other 
Microsoft Programs. Microsoft Power Point and Publisher are similar structured and easier to 
learn once you already have a foundation in Word and Excel. Be creative and be free.  


